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Innovator 14.3 (Innovator 14.3.1.40111) 

 Version Consistency 

Please note when updating your Innovator installations:  

Identity of model server version and client version is highly recommended for safe use of Innovator. It is 
mandatory that model server and clients have identical release numbers (XX.X.X). 

To fix the Log4j security vulnerability, we recommend that you apply the latest hotfix to all clients and servers 
promptly! 

The hotfix 14.3.1.40111 is interface-compatible with the previous versions 14.3.1.XXXXX. 

Repositories updated by transformation cannot be used in older versions.  

Overview of Version Numbers (Builds) 

Product Description Version Number (Build) 

Innovator 14.3.1 Hotfix Version 14.3.1.40111 

Innovator 14.3.1 Hotfix Version 14.3.1.31215 

Innovator 14.3.1 Hotfix Version 14.3.1.30413 

Innovator 14.3.1 Hotfix Version 14.3.1.30127 

Innovator 14.3.1 Hotfix Version 14.3.1.20629 

Innovator 14.3.1 Version 14.3.1.20507 

About the API Documentation 

The API changes are continuously documented in the online help (see "User Customizations> 
Innovator SDK Documentation Library>Change Log"). 

General Functions 

 Log4j Security Vulnerability 

All occurrences of log4j in insecure versions 2.x have been migrated to version 2.17.1. 

The already non-critical uses in InoHub and InoAgent were also updated to 2.17.1 in the process. 

Due to the version swap (and the resulting different library name), classpaths in engineering actions need to 
be adjusted — this is done automatically for all engineering actions configured in the model when the model 
server is first started. 

Please note: The repository can then no longer be started with an older server version. 

ATTENTION: If a log4j library in version 2.x < 2.17.1 is still included via the mechanism of the inojvm.ini, it is 
mandatory to change this, otherwise the security vulnerability still exists! 

◼ New Function 

 Changed 
 Fixed 
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Innovator 14.3 (Innovator 14.3.1.31215) 

General Functions 

 Log4j Security Vulnerability 

All occurrences of log4j in insecure versions 2.x have been migrated to version 2.16. 

The already non-critical uses in InoHub and InoAgent were also updated to 2.16 in the process. 

Due to the version swap (and the resulting different library name), classpaths in engineering actions need to 
be adjusted - this is done automatically for all engineering actions configured in the model when the model 
server is first started. 

Please note: The repository can then no longer be started with an older server version. 

ATTENTION: If a log4j library in version 2.x < 2.16 is still included via the mechanism of the inojvm.ini, it is 
mandatory to change this, otherwise the security vulnerability still exists! 

Model Editor 

 BPMN Import Sets the Name of the Group 

When a group is imported into BPMN, it receives the referenced category value as its name. 

 DMN: Import from Binding on Decision 

A decision with binding to context entries of another decision can be imported without loss. 

 I/O Spec Links: Text Formatting 

For special I/O spec links in formatted texts, the font formatting (Family and Size) is preserved for the link text 
on saving. 

 Excel Import Accelerated for Large Target Models 

When importing an Excel file, it takes a certain amount of time until a model element is found in the Innovator 
model for the rows of the Excel file based on name, stereotype and owner, if there is one. Even with large 
Innovator models, this time amounts to a few seconds per 100 rows. 

 BPMN: Undo Reconnect and Delete Message Flows 

If a message flow between participants or their referenced processes within a collaboration is reconnected or 
deleted, then this can be undone without an error message. 
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Innovator 14.3 (Innovator 14.3.1.30413) 

Model Editor 

◼ Hyperlink Font 

In the "Options" dialog, the two options "Font Family of Copied Model Elements" and "Font Size of Copied 
Model Elements" determine how copied model elements are formatted when pasted as hyperlinks in 
programs such as Microsoft Word. 

 ArchiMate Import: Automatic Corrections 

The ArchiMate import can correct some errors automatically. 

The logical direction of concept connections is not important in many tools, but in Innovator one of the 
connected concepts must be the owner, and this defines the direction. During import, the direction is 
automatically corrected. 

Element names can contain line breaks in some tools, but not in Innovator. Such line breaks are removed and 
the name is transferred correctly. 

Various errors in diagrams, such as multiple nodes of the same object at the same position, nested nodes 
which cannot fit into each other in terms of size, and edges which end at a container but should lead to a 
contained node, are corrected if the necessary information can be determined in another way, and do not lead 
to the import being aborted. 

The import no longer aborts without comment as a result of errors in the imported file. 

All automatic corrections are logged. 

 Copying Entity Relationships Evaluates Create Defaults 

Entity relationships are copied automatically when copying the connected entities. When pasting, the entities 
and their relationships are created in the selected package by default. If the configuration does not allow 
relationships in the selected package as content, the entity relationships are redirected to a suitable package 
via create defaults. 

 Deleting From Clauses Deletes Using Features 

View attributes as well as view columns are also deleted when all their From clauses used in the expression are 
deleted. 

 F3 Text: Default Font in Tables 

Tables newly created in specification texts get font type and size according to the formatted text defaults 
specified in the options. 

 DMN: Simulation of Informations of the "date and time" Type 

Informations (Input Data) of the type "date and time" can be simulated. 
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 Impact Analysis: Custom Behavior is Inherited 

When you create a custom behavior for an element or stereotype in the impact analysis, the existing custom 
behavior of its stereotype or element type, if any, is inherited. This is true for both display and content 
behaviors. For example, if you have already defined the Name and Owner properties and a node color for 
display for a stereotype, then these properties and this color are also inherited in the conditions when you 
create a custom behavior for an element of this stereotype. 

 Model Fragments: Importing Entities Without Their Relationships 

Importing model fragments is also successful with entities without their relationships. Referenced entities are 
imported as placeholders if necessary. 

 Placeholder Replacement in Formatted Texts 

Placeholder replacement ($(name)-expansion) in formatted texts no longer leads to inconsistency of the text 
in special cases. 

Plug-Ins 

◼ Bpanda Connector Supports Re-Import 

A process exported from Innovator to Bpanda can be edited there. The changed process can then be imported 
again from Bpanda to Innovator and further edited there. This applies regardless of how many processes are 
exported, as long as they are exported without Innovator look. 

◼ Bpanda Connector: Translations are Imported 

With Bpanda Connector you can import a process from Bpanda to Innovator. Existing translations in Bpanda 
are taken over in all languages which exist in the Innovator model as display languages. The modeling language 
in Bpanda and Innovator must be the same. The translations are also adopted under the same conditions if 
you import a BPMN file exported from Innovator into Innovator. 
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Innovator 14.3 (Innovator 14.3.1.30127) 

Administration 

 Loading User Configurations 

Loading different user configurations multiple times does not result in shutdown of the model server. 

 PowerShell: Creating a Model Version 

The creation of model versions with the commands "New-InnoManagedModelVersion" and "New-
InnoManagedModelVersionBackup" is done correctly even with unfavorable response time behavior of the 
involved model servers. 

Model Editor 

◼ BPMN Import: Import Subprocess as Task 

When importing a BPMN file, you can specify as an option that a subprocess without content is imported as a 
task of the "call activity" task type. (A subprocess with lanes is always imported as one process and one task 
calling it). 

 ER-DB Automapping: Types from Local Columns to Foreign Attributes 

If an entity is automatically mapped into a DB model, but the referenced entity of one of its foreign keys is not, 
then this foreign key cannot be created in the DB model. However, the related columns are created as local 
columns with the correct data type. 

Changes to the type of a referenced attribute are also mapped to these columns. 

 ER-DB Mapping: Mapping Packages as Schemes 

In the standard mapping from the conceptual model to the database model, a schema is created in the 
database model for a package, even if it has a different stereotype than subject area. You can customize this 
behavior by changing the values of the options "de.mid.data.CreateTemplatePackage" and 
"de.mid.data.CreateTemplateSchema" and customizing the step "Package2Schema". 

 ER-DB Mapping: Split Foreign Key Attributes 

After splitting a foreign key attribute, the resulting attributes derive the Null property from the matching 
relationship. 

 Model Fragments with Merged Foreign Key Attributes 

Model fragments with merged foreign key attributes or columns can be imported even if the current entities 
or database tables have not yet merged them. 
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 Specification Texts: Spell Checking Slightly Delayed 

Writing text in the specification text editor happens smoothly because the built-in spell checker is slightly 
delayed. 

 UML: Types of Exception Input Pins 

The list of available types is restricted for the exception input pin via the connected exception handlers. All 
exception types and their generalizations are allowed. 

 BPMN: Name Maintenance for Linked Partner Entities 

Automatically matching the name of a participant to a newly linked partner entity takes effect immediately. 

 Changing Element Type Maintains the Hierarchical Subordination for Organizational Units 

If the element type for an organizational unit is changed to a different stereotype, the linked hierarchical 
subordinations are accordingly reconnected and the owner relationship of the organizational units is adjusted, 
if necessary. 

 DB/DDL Import: Standard Import Remembers Selected Database Elements 

If the database elements selected during a previous import are not in the visible area in the Import Wizard at 
"Step 4: Select database elements", then this is indicated by the partially marked display of the selection field. 
This avoids the unnoticed import of already imported database elements. 

 DDL Import Supports Omission of the Alias 

Importing a DDL file can create a database view even if the alias is not specified in the From clause. 

Example: 

CREATE OR REPLACE VIEW MyView AS SELECT 

  Name 

FROM 

  TableA 

  LEFT OUTER JOIN TableB ON TableA.Id = TableB.Id 

  LEFT OUTER JOIN TableC ON TableA.Id = TableC.Id 

; 

 Diagram Copy: Handling of Constraints Corrected 

If you copy a diagram, then all graphic contents are copied with the connections to the logic. If the copy set 
also contains a part of this logic, the connections will be redirected to the copied logic. Constraint connection 
edges, which are connected to the wrong graphic by the different adoption of the logic, are automatically 
removed from the copied diagram. The copied diagram ensures that all constraint nodes are fully displayed. If 
necessary, connection edges to existing graphic contents are automatically added. The constraint node is 
removed from the diagram if not all connection edges can be added. 
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 Drag-and-Drop from Used Event Definition to Event 

When an event definition is dragged onto an event, the event definition is assigned to that event. If the same 
event definition is again dragged onto the same event, no change is made and no message regarding double 
usage occurs. 

 ER-DB Mapping: Split of Merged Database Tables 

Merged database tables with unexpected or missing mapping dependencies to ER elements are treated as 
unmapped database tables when split up again. 

Due to missing information, the result of the splitting can be different from mapped tables and may have to be 
post-processed. 

 Model Fragment Import: Changed Translations are Adopted 

If a model fragment is imported with modified translations, then these translations are correctly adopted. 

 OO-ER: Map the Multiplicity of an Association Role 

When mapping from an object-oriented model to a conceptual model, the multiplicity of an association role is 
transferred to the cardinality of the role in the entity relationship. 

Please note that the notation of multiplicity in UML notation is different from, for example, cardinality in Chen 
notation. Therefore it looks like the role is on the other side of the entity relation. 

 Search Clears Initial Cache 

The model editor works on cached server results. In order for a search to find other users' changes 
immediately, it initially clears the cache. 

 UML: Composite Structure Diagram: Create Port on Part Node 

In a composite structure diagram, a port can be created on a part node. The port is created as the content of 
the type of the part property. 

 Undo Without Privilege "Configurating" 

If you change a text on a protected package via API or property editor, this change can be undone even 
without the "Configurating" privilege. 

Configuration 

◼ DDL Generation: Table Column with Direct Sequence 

Table columns can be used directly like sequences - similar to the DDL generators for sequence data types. For 
this purpose, a stereotype property of type "Enumeration" with the name "GenerationType" and the values 
"DEFAULT" and "ALWAYS" must be configured. For more information, see the help chapter "Special Functions 
for DDL Export". 

 Translations of Configuration Contents are Also Copied 

When copying configuration contents, all existing translations are included. 
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 Visibility of Properties in Dialogs 

In the configuration editor on stereotypes, the visibility in dialogs may be restricted for all available properties. 
For an element of the corresponding stereotype, the Model Editor then only displays the approved properties 
in the Properties tool window. This prevents users from being able to manipulate fixed values. The fixed values 
are typically set in the create templates. For this reason, all other available properties are also provided for 
modification in the create templates, in addition to the properties configured as visible. 

 Details Configurations are Sorted by Profile Order 

In the configuration editor, the Details configurations are displayed in the order of the profiles. This sorting 
corresponds to the evaluation order in the Details area. 
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Innovator 14.3 (Innovator 14.3.1.20629) 

Model Editor 

 ArchiMate Import: Reuse Existing Elements 

The import of files of the ArchiMate Model Exchange File Format works as expected. If an ArchiMate element 
is contained more than once in the files to be imported, or if it is already present in the namespace used for 
import, the existing element will be reused. The created diagrams correspond to their counterparts in the 
source model in terms of content and presentation.  

 BPMN Export Considers Translations of Properties 

When exporting BPMN processes for which translations exist, the translated names and values of the 
properties are transferred to the export file. 

 BPMN Export: Supporting Process is Exported 

The export of a BPMN file exports the support of one process by another process. 

 BPMN: Owner of Data Input and Output Not Changeable 

Data associations always run between two data objects. If you create a data association between a task and a 
data object, an invisible data object is created in the task and, depending on the direction, the data object type 
is defined as data input or output. For this hidden data object, the change of owner is rejected with an error 
message. 

 Compartments: Position Y Irrelevant for Undo 

For compartments, the Y position is ignored when undoing.  

 DDL Generation: Combined Subselects 

If a view has the stereotype "fromCombinedSelect" and is the target of a From clause, then the appropriate 
SELECT will be generated for the From clause in the DDL. 

 Diagrams: Standard Layout According to the Sugiyama Algorithm 

In the diagram editors, the command "Design>Arrange>Standard Layout>Arrange Diagram" is executed 
correctly. 

 Download of Repair Data 

Repair data can be downloaded in the Administration Program. These files are downloaded in the background 
and without timeout. You can continue working while the download is running. When the action is completed, 
Windows Explorer opens with the selected directory. 

 Excel Import Supports Formulas 

When importing Excel files, the values that are calculated by formulas are also imported. 
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Configuration 

 Filtering of Stereotypes in the Documentation 

In the configuration of a documentation, element enumeration chapters can be filtered by stereotypes by 
specifying a filter. If the filter starts with '?', then all elements are also permitted for which a super stereotype 
fulfills the specified name. 

 Consistency of Display Format Rules 

For display format rules, the same sequence number is not reported as inconsistency. 
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Innovator 14.3 (Innovator 14.3.1.20507) 

General Functions 

◼ Impact Analysis Diagram: Faster Creation 

Impact analysis diagrams can be created directly for any model element using the context menu command 
"New Impact Analysis". In the configuration, you must define the properties with which the impact analysis is 
set up for the respective stereotype. 

In the configuration editor, the "Applicable Start Element" property or, from the point of view of the start 
element, the "Applicable Analysis Diagram" property can be configured for any stereotypes of analysis 
diagrams. 

In the creation template of the analysis diagram, the names of the content and display configuration can be 
set. The corresponding configuration is then linked when the creation template is evaluated. If no 
configuration is set, then the configuration with the name "Default" is used by default. 

In the Model Editor, the analysis diagram creation template is supplied in the "New Impact Analysis" context 
menu of the corresponding element based on this configuration. When the creation template is evaluated, the 
selected element is used as the start element and its name is also adopted. 

◼ Language Support: Create and Display Models Completely in Additional Languages 

Innovator models can be created completely in other languages (in addition to German and English). Any 
model language can be selected from the supported languages for a new model. 

In addition to diagrams, the supported languages can also provide all other model contents and all relevant 
information from the profiles and the metamodel as a model which is linguistically consistent at all levels. The 
display languages can be used for the presentation and documentation of any aspect of the model. 

The new backstage view "Manage Languages" contains all functions for managing and selecting languages and 
for data exchange for external translations. 

With the "Translation" tool window, all actual model content can be translated internally. A web service like 
DeepL can be used for this purpose. 

For a high-quality translation based on translation memories and uniform terminology, the use of an external 
translation via the interface files is recommended. 

 Access to Java Settings (inojvm.ini) 

For the Java settings the file inojvm.ini is read from the directory $INOHOME. If the file does not exist there, it 
is read from the $INODIR directory. 

 Character '#' not Allowed in Model Names 

The '#' character can no longer be used in model names. When a repository is transformed to version 14.3, the 
character in model names is automatically replaced by '_'. Local model files must be renamed before 
transformation. 
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 Conversion to Unicode (UTF-8) 

Starting with version 14.3, the model server uses the UTF-8 encoding for character representation. Therefore, 
characters outside the previously used character set Windows 1252 (CP1252) can be used for modeling. 

For regular expressions the regular expressions of the ICU library are used (see http://userguide.icu-
project.org/strings/regexp). 

For model servers without single sign-on, this change may cause problems with the migration of passwords. 
Please refer to the Migration Manual. 

 Language Support: Useable Languages 

Language support has been extended to all official languages of the member states and candidate countries of 
the European Union, as well as Russian and Turkish, in addition to the languages previously supported. 

Administration 

◼ Language Support: View and Edit Settings 

Language support settings can be displayed and edited in the administration program. A model administrator 
rule is required. When selecting a running managed model or a standalone model in a single sign-on 
repository, the settings for the model and display languages can be changed using the menu command 
"View>View>Edit Properties". 

◼ PowerShell Automation Commands 

For better management, a PowerShell library is available for individually automating common actions around 
standalone and managed models. For example, it is possible to start or stop managed models on a scheduled 
basis or to create new versions and backups. The library is installed under Windows along with the client or 
server components. The provided functions will check - as far as relevant - the available authorizations in the 
user administration. 

◼ Version Management: Define Naming Scheme for Versions 

For a managed model, a naming scheme can be defined at the root node, which is supplied for creating new 
versions. Some placeholders can be used in this naming scheme. In addition, a regular expression can be 
defined that must be satisfied by the name of a new version. These settings can be made separately for 
subsequent versions and backups. 

◼ Version Management: Guarantee Delivery of Particular Versions 

In the ribbon group "Model>Model Version" there is a toggle command "Protect From Shutdown" for 
managed models. With this command a user with environment right can define for a selected running model 
version that it may only be terminated with environment right. This can be used to ensure that a model 
version in which many modelers are working is not inadvertently terminated. 

◼ Version Management: Migration of Agent Settings 

When migrating managed models, settings that are managed for the agents, such as the list of model servers 
that are booted when the agent starts, the quotas of the managed models and the agents themselves, are also 
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transferred. For correct functioning, version-dependent path components must be renamed after the 
transformation and before starting the agents. See the Migration Manual for more information. 

 Central User Administration: Effect of the First Rule 

If there is no rule for any rule type in the central user administration on the main license server, all users may 
use the functionalities restricted by the rule types to the full extent. This makes it easier to start up Innovator. 

As soon as a rule exists for any rule type, only the functionalities accessible by this rule type can be used. 
Explicit rules must be created for each rule type to be able to use the functionalities of other rule types. 

Model Editor 

◼ "Administrative Content" View in the "Model Content" Toolwindow 

In the "Model Content" tool window, the Model Administrator has a new "Administrative Content" view that 
shows application configurations, database connections, and translation containers. These elements can be 
e.g. provided from here through model fragment export for import into other models. 

◼ Application Configurations: Custom Configuration is Removed During Deployment 

To simplify working with application configurations, the custom configuration is deleted after deployment as a 
model-wide configuration. 

◼ Application Configurations: Filtering Lists 

The lists of configurations of the different applications can be filtered to a text pattern. These filters are 
available across sessions. 

◼ BPMN Export and Import Support Resources 

The BPMN export and the BPMN import support resources. During export, the assigned resources and their 
assignments to the process, task, subprocess and lane are exported. During import, an existing resource with 
the same name is assigned, otherwise a new resource is created. Innovator only supports one resource in the 
process. The resources on the lane are exported to the Innovator extension. 

◼ BPMN Import can Reuse Global Elements 

When importing BPMN, the user can specify whether global elements should be reused. A global element is an 
event definition, a signal, a global task, a global condition, a message, a data store, an error, an escalation or a 
business object. If an element of the same name and type exists, it is reused. If there are several elements with 
the same name, the element from the nearest package is reused. If there are several elements with the same 
name that are structurally equally distant, none is reused. 

◼ Concept Diagram: Copying Nodes to Another Concept Diagram 

Several nodes can be selected in a concept diagram, copied to the clipboard using the context menu command 
"Copy representation for another diagram" and added to another concept diagram using "Paste 
representation from another diagram". In addition to the selected nodes, all contained nodes and all edges 
running between these nodes with their current coordinates are copied and inserted in the new diagram 
relative to the position of the mouse pointer. 
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◼ DDL Generation: Encoding of the Output File 

In the DDL configurations, the "Encoding of the output file" option in the "Formatting" group allows you to 
choose the output file format between "UTF-8" as default and "ISO-8859.1". 

◼ Excel Import Supports Localized Element Names 

The import of Excel files can recognize stereotypes by both their logical name and their translated name in the 
model language. The same applies to the names and values of properties. 

◼ Impact Analysis Supports Color Label and Method Colors 

The commands in the "View>Colors" group also work in the impact analysis. The color setting affects nodes 
and edges that represent exactly one model element.  

When set to "Custom Colors", they are displayed with the color set in the display configuration. 

If the "Method Colors" setting is selected, they are displayed with the color configured at the stereotype in the 
configuration editor. 

With the "Color Label" setting, they are displayed with the color configured in the configuration editor at the 
value of the label. 

If no color label or no custom color is configured for a node, it is displayed in white. If no color label or no 
custom color is configured for an edge, it is displayed in black.  

◼ Language Support: Automatic Translation via Web Service 

In the "Translation" tool window the new button "Translate with web service" is available, which allows 
translating selected terms directly with the set web service. Currently, this is the web service DeepL. 

An API access key, which must be stored in the administration program on main and project license servers, is 
a prerequisite for using DeepL in Innovator. If the current combination of model language and display language 
is supported by the web service, the user can use the "Translate with web service" button in the translation 
window. If several model elements are selected, the web service will automatically translate them all. 

◼ Language Support: Backstage View "Manage Languages" 

The backstage view "Manage Languages" contains functions for managing and selecting model and display 
languages and for data exchange for external translations. 

For a new model, one of the supported languages can be selected as the model language in which the 
modeling is to be performed. Several languages can be defined as alternative display languages for 
presentation purposes. 

For the purpose of external translation into the display languages, the export of model elements (e.g. names, 
property values, specification texts), profile content (e.g. stereotype names, property names, label values) and 
meta model content (e.g. element type names) in various formats (XML, Json, CSV, Excel) is supported. 
Additionally, filtering according to the state of existing translations is possible. After the translation is 
complete, the files can be re-imported here. 

The privilege "Translating" is required for exporting and importing translation files. 

The model administrator right is required to import meta model contents into stand-alone models. 
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◼ Language Support: Translate Specification Texts 

Specification texts can be translated both via the "Translation" tool window and via the export and import of 
translation files. Since the syntax and structure of the texts in another language can change significantly, it is 
not possible to automatically adopt existing formatting. Existing texts and formatting will be overwritten 
during a new translation. 

A special editor for specification texts can be called up in the translation window with the "Text..." button. This 
editor displays the specification text in the model language and the display language side by side. All 
formatting functions are available for the text in the display language. Using the command 
"Text>Font>Transfer Format", formatting and hyperlinks from the text in the model language can easily be 
transferred to the display language. 

◼ Synchronize Model Elements: Changesets and Searches of the Left Model can be Used 

To determine the model elements to be compared, changesets and searches of the left model can be used, 
too. The commands are available in the toolbar of the selection area and its context menu. They call up the 
corresponding selection dialogs. 

◼ Synchronize Model Elements: Fast Comparison of Elements 

Elements outside of diagrams can be compared with a corresponding counterpart from another version of the 
model using the context menu command "Quick Compare". If the selected element is a diagram, the diagram 
comparison is automatically displayed. 

◼ Tables for Properties and Content: Distributing Equal Values to Several Cells 

For tables for properties and contents, the command "Design>Edit>Adopt Value" is available. This allows the 
value of the current cell to be transferred to the cells of the same column of the selected rows if several rows 
are selected. 

◼ Whiteboard Diagram Allows Concept Connections 

An extended whiteboard diagram configuration allows you to add or create concept connections between 
contents of displayed concept diagrams. 

 Backstage View "Change Sets" Revised 

On the backstage view "Change Sets" the labels on the buttons and their arrangement have been revised for 
better comprehensibility. 

The "Continue" button has now the following behavior: 

The change set automatically created at login is displayed in the table and can be named speaking. 

The user is involved in the change set selected in the table, after which the backstage is closed. 

 BPMN: Standard Jump of Processes Changed 

The standard jump of processes goes to the process definition instead of the process diagram. All process 
contents are also affected by this change, because the process determines the representation that is jumped 
to. If a process is called in a task, the standard jump leads to the process definition of the called process. 
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 Concept Connections: History Information is Created 

The creation and modification dates are logged for concept connections. 

To improve conflict detection during model merging, other element types have also been given a history. 

 DB/DDL Import/Export: Directory for Sequence Controlling Files 

The directory $INODIR\java\InoIMInOut\configuration contains all sequence controlling files for DB/DDL 
import/export. These files have been added: 

 *  stereos.xml with the customizable stereotypes used during import 

 *  stereotypeoptions.xml for converting DB options to type system options in the model during import 

 *  positions.xml for the positioning of type system options during DDL export 

 *  datatypes.xml for converting JDBC data types to Innovator data types during import and comparison with 
the model and the differences DDL export in the DB Manager 

 ER-DB: Mapping Editor Displays Linked Model Elements in Turquoise 

In the "Mapping" editor, a model element is displayed in the "Target Model" area on the right with the color 
turquoise if it has been linked via a mapping dependency and its properties have not been changed by the 
mapping. 

 Impact Analysis Saves Selected Configuration 

When the user selects a model-wide content or display configuration in the "Impact Analysis" context tab, this 
configuration is saved on the analysis diagram if the user has the necessary access rights. 

 Impact Analysis: Display Names of Paths 

By default, the display name of a path composed of contiguous edges and nodes is the name of the first and 
last model element separated by three dots. For semantically clearer naming, an explicit name can be 
assigned, which is then always used for the path. 

 Language Support: Behavior of the Model Editor When a Display Language is Selected 

If a display language is selected instead of the model language via the status bar or the "Translation" tool 
window, the model editor displays the contents (diagrams, properties area, model tree, details area, etc.) in 
this language as far as translations exist in the model.  

For untranslated content, other available languages will be used. The logical name is then displayed for model 
content. Profile and meta model elements are accessed in the following order: display language, model 
language, interface language (INOLANG), and logical name.  

A clearly visible notification is displayed below the ribbon when the user uses the model in a display language. 

The purpose of this mode is to display the contents in the selected language, generate documentation, and 
create or edit the translation in this language. Some other functions of the model editor are therefore 
restricted. It is not possible to edit the model contents, this concerns the creation of new elements and the 
editing of their properties or even a model synchronization. Exports and imports of model contents (except for 
translations) are not possible. 
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 Language Support: Calling Functions for Integrated Translation 

The "Translation" tool window can be reached via "Review>Translation>Translate model elements". The 
"Translation" group also contains the commands for verifying the existing translations.  

The call of the translation window via "View>Windows>Tool windows" has been removed. 

 Language Support: Functionality and Handling of the Translation Window 

The functionality and handling of the "Translation" tool window has been revised. 

Translatable contents are listed according to the existing selection of elements. A package provides the 
contained elements and the translatable properties for these elements. A diagram provides the translatable 
properties needed to display the diagram content. If you select an individual element, its translatable 
properties are listed. For example, a class also provides all attributes and operations. 

The buttons "Delete", "Not to be translated", "Out of date" and "Up-to-date" allow you to set the states for 
one or more translation entries. 

 Version Management: Engineering Actions in Backups of Managed Models 

Read-only engineering actions can be used in the always read-only backups of managed models. 

 BPMN Export Exports Artifact as Text Annotation 

The export to BPMN exports an artifact as text annotation. Thus, another BPMN tool can import it as text 
annotation. When importing a text annotation, an artifact or a comment is created from it, depending on the 
existing extension. 

 BPMN: Evaluation of the Content Configuration for Lanesets without Lane 

The evaluation of the content configuration also works if a process may contain a laneset as an assigned 
element, but the laneset may not contain a lane. The model server does not shut down immediately upon 
login. 

 Details: Merging Identical Nodes 

In the "Details" tool window, nodes are merged under a heading when the same element is displayed. The 
displayed name is also included in the assessment of whether an element is the same. 

 DMN: User-defined Data Types in DMN 1.2 

When referencing user-defined data types, the namespace is exported in the correct format. 

 Role Change with Diagram Opened 

Performance has been improved when changing roles while diagrams are open. 

 UML: Creating Port Nodes 

When creating port nodes, an error message is displayed if the selection is unfavorable, thus preventing the 
server from being inconsistent. 
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Configuration 

◼ BPMN: Assignment of Boundary Events to a Task 

The property "Boundary Event" of the element types "Task", "Sub-Process" and "User Input Task" is 
configurable. This allows restricting the list of allowed events. 

The model templates already contain the configuration so that the events can be used without problems. 

The configuration is also included in the migration profiles. 

During the transformation, the "Boundary Event" property is configured in the profiles in which the owner is 
defined for the task, sub-process or user input task or event. 

 Dialogs in the Configuration Editor 

Due to extended language support, the dialog for localized names and the dialog for element headings in 
documentation chapters  have been redesigned. Since other languages besides German and English can be 
used, corresponding drop-down lists and registers have been integrated. 

In the dialog for localized names an entry can be made in one input line for the selected language. 

The dialog for element headings in documentation chapters allows using placeholders for language-neutral 
composition of element headings in a separate tab. The property is also displayed in the "Properties" tab and 
its value can be changed there if necessary. 

If a language-dependent variant is required, there is a new tab "Element heading (localized)", where you can 
select the desired language from a list and enter a value in the input line. 

For normal cases, this provides a dialog for composing the generic, language-neutral element heading from 
placeholders, while for the exception of specific names in the supported languages only the input field exists, 
where placeholders (e.g., in a different order) can be used as well. 

 Details Configuration: Inserting Copied Documentation or Details Chapters 

When inserting copied documentation or Details chapters into the Details configuration, it is ensured that the 
copied chapters are permitted at the insertion point. Restrictions can result from the type of chapter or the 
represented element type. 
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